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chapter 1

COMPUTER DIAGNOSTIC
FEATURES

Computer Diagnostics

D The following section applies only to computers equipped with
adiskette drive.

Compaq strongly recommends that you create a diagnostics diskette as
soon as you begin to use the computer. This is a bootable diskette that
allows you to test and inspect the hardware outside of the operating
system by running the Computer Checkup (TEST) or View System
Information (INSPECT) diagnostic programs. The diskette will play an
important role in the restoration process if you ever experience a major
system failure.

Another Compag diagnostic feature is Compag Diagnostics for
Windows, described later in this guide.

Create a Diagnostics Diskette

Windows-Based

Not all Compag computers equipped with Windows NT support
this feature.

Using the Windows or Windows NT operating system:

Click Start = Compaq Information Center = Create Diagnostics Disk.
Insert adiskette into the diskette drive and follow the instructions on
the screen.
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Computer Checkup (TEST)

Use Computer Checkup (TEST) in the following instances to:

Determine if al the devicesinstalled on the computer are
recognized by the system and functioning properly. Running
TEST isoptional but recommended after installing or connecting a
new device.

Third party devices not supported by Compag may not be
detected.

Save, print, or display the information generated by TEST. You
should run TEST and have the printed report available before
placing a call to the Compag Customer Support Center.

Reproduce the same environment on another computer for testing.
Before you run TEST, you must create a diagnostics diskette.
See the “ Create a Diagnostics Diskette” section of this chapter
for instructions.

Turn off the computer.

Disconnect all peripheral devices other than the keyboard and
monitor. Do not disconnect the printer if you want to test it or use
it to log error messages.

Install loop-back and terminating plugs to test external ports if
desired.

Cold boot your computer from the diagnostics diskette you have
created. At the title screen, select the Advanced mode (Ctrl+a).

Select Computer Checkup (TEST)

Select the option to view the devicelist. A list of theinstalled
hardware devices appears.

Verify that TEST correctly detected the devicesinstalled. This
utility will detect all devices manufactured or supported by
Compag; devices from other manufacturers may not be detected.

O If thelistiscorrect, select OK and go on to step 8.

O If thelistisincorrect, be sure that any new devices are
installed properly.
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8. Select one of the following from the test option menu:

[]

O

O

Quick Check Diagnostics—This option runs a quick, general
test on each device with aminimal number of prompts. If
errors occur, they are displayed when the testing is complete.
This option will only test the first 16-MB of memory.

Automatic Diagnostics—This option runs unattended,
maximum testing of each device with minimal prompts. Y ou
can choose how many times to run the tests, to stop on errors,
or to print or filealog of errors.

Prompted Diagnostics—This option allows maximum
control over the device testing process. Y ou can choose
attended or unattended testing, decide to stop on errors, or
choose to print or filealog of errors.

If attended testing is selected, the test itself may result in data
loss.

Follow the instructions on the screen as the diagnostic tests are run on
the devices. When the testing is complete, the TEST option menu is

displayed again.
9. Toexit TEST, pressthe Esc key to reach the Exit option. Then

press Enter.

View System Information (INSPECT)

Use View System Information (INSPECT) to:

View information about the system once it has been configured.

Save, print, or display the information generated by INSPECT.
Y ou should run INSPECT and have the printed report available
before placing a call to the Compag Customer Support Center.

Assist your Compag authorized dedler, reseller, or service provider
in analyzing the system by allowing the service provider to
reproduce the same environment on another computer for testing.
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The information provided by INSPECT includes:

Contents of the operating system startup files
Current memory configuration
ROM versions
Type of processor and coprocessor
Diskette, CD-ROM, DVD-ROM tape, or hard drivesinstalled
Active printer and communications interfaces
Graphics settings
Windows WIN.INI file details
Before you run INSPECT, you must create a diagnostics

diskette. Refer to the “ Create a Diagnostics Diskette” section
of this chapter for instructions.

Cold boot your computer from the diagnostics diskette you have
created. Press Enter to bypass the title screen, if necessary.
Select View System Information (INSPECT).

Select one of the available options using the Esc key:

O Print the INSPECT status.

O Savethe INSPECT statusto afile.

0 Add commentsto a parameter status.

0 Exit the utility.

To exit INSPECT, press the Esc key to reach the Exit option. Then
press Enter.

Compaq Diagnostics for Windows

Compaq Diagnostics for Windows is a component of Desktop
Management that allows you to view:

System overview
AssetControl information
Input devices
Communications ports
Storage devices

Graphics information
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Memory configuration
System health
Operating system
Windows version
Resources
Multimediainformation

Architecture

Depending on the version, Compaq Diagnostics for Windows may
include diagnostic tests to determine if all the devices installed on the
computer are recognized by the system and are functioning properly.

Installing Compaq Diagnostics for Windows

This operation is required only if the diagnostics program has been
loaded but not installed.

1.
2.

Close any Windows applications.

Double-click the Compaq Diagnostics for Windows icon, located
on the Windows Desktop.

Click Next to install Compaq Diagnostics for Windows.

After the program has finished installing, you may be prompted to
restart the computer, or it may automatically restart. If prompted,
click Finish to restart the computer or Cancel to exit the program.
Y ou must restart the computer to complete the installation of
Compaqg Diagnostics for Windows.

Using Compaq Diagnostics for Windows

1.

[]

Select the Compag Diagnostics for Windows icon, located in the
Control Panel.

The screen displays an overview of the computer hardware and
software.
For specific hardware and software information, select a category

from the Categories menu or from the toolbar.

Asyou move your cursor over the toolbar icons, the
corresponding category names appear near the cursor.
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3. Todisplay more detailed information in a selected category, click
Morein the Information Level box.

D Categories or items of information displayed by Compaq
Diagnostics for Windows are similar to but may vary slightly
from the information presented in View System Information
(INSPECT).

4. Review and print thisinformation.

D To print the information, click File, then select Print. Select
one of the following options: Detailed Report (All Categories),
Summary Report (All Categories), or Current Category. Click
OK to print the report you selected.

5. To exit Compag Diagnostics for Windows, click File, then click
Exit.

Running Diagnostic Tests

1. Select the Compag Diagnostics icon, located on the Control Panel.

The screen displays an overview of the computer hardware and
software. If your version of Compaq Diagnostics for Windows

includes diagnostic testing utilities, four tabs will appear next to
Overview: Test, Status, Log, and Error.

2. Select the Test tab.
3. Select one of the following options:

0 Quick Test—Runs aquick, general test on each device with a
minimal number of prompts.

0 Complete Test—Runs maximum testing of each device with
minimal prompts.

0 Custom Test—Runs only the tests you select. To select
specific devices or tests, find the devicein the list, then click
the box beside each test to select or deselect it. When selected,
ared check mark appearsin the box.

4, Select Interactive Mode or Unattended Mode.

In Interactive Mode, the diagnostic software will prompt you for
input during tests that require it. Some tests require interaction and
will display errors or halt testing if selected in conjunction with
Unattended Mode.
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5. Click the Begin Testing button.

Test Status is displayed, showing the progress and result of each
test.

6. |If errorsarefound, click the Error tab to display more detailed
information and recommended actions. By following the
recommended actions, you may be able to solve some problems
yourself.

7. Click Print or Save the error information in case you need to
contact your Compaq authorized dealer, reseller, or service
provider for assistance.

To exit Compaq Diagnostics for Windows, click File, then click Exit.

Protecting Your Software

To protect software from loss or damage, you should keep a backup
copy of all system software, applications, and related files stored on the
hard drive. Refer to the operating system or backup utility
documentation for instructions on making backup copies of datafiles.
Another option is the Compaqg Deskpro Supplement CD or the Compaq
Restore CD which accompany many desktop and workstation models
and enables the user to selectively restore the original system software.

Compaq Restore CD

The Compag Restore CD that is shipped with select computers offers
easy recovery of the critcal system software. Along with the Microsoft
operating system CD, the Compaq Restore CD enables the user to
restore the original base system software. This can be extremely helpful
in the event of hard drive failure or corruption.

The Compag Restore CD is specific to each desktop and workstation
model and accompanies many computers along with the Microsoft
operating system CD.
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chapter 2

TROUBLESHOOTING WITHOUT
DIAGNOSTICS

This guide provides information on how to identify and correct minor
disk, graphics, memory, and software problems. It also explains many
of the messages that may be displayed on the screen, including specific
error messages that may appear during the Power-On Self-Test (POST)
at startup.

POST Message Disabled suppresses most system messages during
POST, such as memory count and non-error text messages. In this
mode, the Compag Logo and Web address appear on the computer
monitor. If aPOST error occurs, the screen will display the error
message. To manually switch to the POST Messages Enabled mode
during POST, press any key (except F10 or F12). The default mode is
POST Message Disabled.

The speed at which the computer loads the operating system and the
extent to which it is tested are determined by the POST mode selection.

Quick Boot isafast startup process that does not run al of the system
level tests, such as the memory test. Full Boot runs all of the ROM-
based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on aregularly
scheduled basis. To establish the schedule, reconfigure your computer
to the Full Boot Every xx Days mode, using Computer Setup.

(] For moreinformation on Computer Setup, refer to the
Hardware Reference Guide.
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Helpful Hints

If you encounter some minor problem with your computer, monitor, or
software, refer to the following list of general suggestions before taking
further action:

Check that the computer and monitor are plugged into aworking
electrical outlet.

Check to see that the computer is turned on and the green power
light ison.

Check to see that the monitor is turned on and the green monitor
light ison.

Turn up the brightness and contrast controls of the monitor if the
monitor is dim.

Press and hold any key. If the system beeps, then your keyboard
should be operating correctly.

Check all cable connections for loose connections or incorrect
connections.

Reconfigure your computer after installing a non—Plug and Play
expansion card or other option. See “ Solving Hardware Installation
Problems” for instructions.

Be sure that all the needed device drivers have been installed. For
example, if you are using a printer, you need a printer driver.

Take out al diskettes from the diskette drives when you turn on
your system.

A CAUTION: When the computer is plugged into an AC power source there is

always voltage applied to the system board. You must disconnect the power
cord from the power source before opening the computer to prevent system
board or component damage.
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Solving Minor Problems

Y ou may be able to easily resolve the minor problems described in this
section. If aproblem persists and you are unable to resolve it yourself
or if you feel uncomfortable about performing the operation, contact
your Compagq authorized dealer or reseller.

Problem

Cause Solution

Computer won't turn on.

Computer is not connected to Connect to an external power source.
an external power source.

Cables to the external power Ensure that cables connecting the

source are unplugged. computer to the external power source
are plugged in properly and the wall
outlet is active.

A defective PCl or ISA card has Remove any expansion card that was

been installed. just installed.
Drive power, data, or power Reseat drive power, data, and power
supply cables may not be supply cables.

properly connected.

Computer appears locked

Software control of the power Press and hold the power button for at

up and won'’t turn off switch is not functional. least 4 seconds until the computer turns
when the power button is off.
pressed.
Computer date and time RTC (real-time clock) battery First, reset the date and time under
display is incorrect. may need to be replaced. Control Panel. If the problem persists,
Battery life is approximately replace the RTC battery. Refer to the
3 years. Hardware Reference Guide for

instructions on installing a new battery,
or contact your Compagq authorized
dealer or reseller for RTC battery
replacement.

Computer powered off
automatically

(Red power LED blinks
four times per second).

The unit temperature was 1. Unitis in an exceedingly hot
exceeded. The fan may be environment. Let it cool down.
blocked. 2. Ensure computer air vents are not

blocked and internal fan is running.

3. Contact your Compaq authorized
reseller or service provider.

The unit temperature was Replace cover or access panel, and let
exceeded because the computer ~ the computer cool down before

was functioning with the cover or attempting to turn on power to the
access panel removed. computer.

Continued
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Solving Minor Problems continued

Problem

Cause

Solution

Computer appears to
pause periodically.

Network driver is loaded and
no network connection is
established.

Establish a network connection, or use
Computer Setup or Windows Device
Manager to disable the network
controller.

Poor performance.

Insufficient power to the
components.

Ensure both power supply cables are
connected to the system board (some
workstations).

Cannot remove computer
cover or access panel.

Smart Cover Lock, featured on
some computers, is locked.

Unlock the Smart Cover Lock using
Computer Setup (F10 Setup).

The Smart Cover FailSafe Key, a
device for manually disabling the Smart
Cover Lock, is available from Compagq.
You'll need the FailSafe Key in case of
forgotten password, power loss, or
computer malfunction.

Cursor will not move
using the arrow keys on
the keypad.

The NumLock key may be on.

Press the NumLock key. The NumLock
light should not be on if you want to use
the arrow keys.
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Solving Power Supply Problems

Problem

Cause

Solution

Computer won't turn on
(Power LED on front of
computer not on).

Computer is not connected to
an external power source.

Connect to an external power source.

Cables to the external power
source are unplugged.

Ensure that cables connecting the
computer to the external power source
are plugged in properly and the wall
outlet is active.

Power switch not connected to
the system board.

Plug the power switch cable into the
system board.

Power line selector switch on
rear of computer chassis not
switched to correct line voltage
(115V or 230V).

Select the proper AC voltage using the
slide switch.

Power LED blinks RED 1
time per 2 seconds.

Power supply overloaded or
short was detected.

Unplug computer from AC power.
Unplug internal power cables from all
devices and unplug all PCI cards.
Reconnect devices one at a time and
turn power on to identify the cause.

Diskette drive power cable not
properly connected.

When installing power cable to diskette
drive, ensure that all 4 pins on the drive
are connected to the power cable
connector.

Power supply shuts down after
system warms up. Thermal
overload caused by bad fan.

Replace power supply.

Power supply will not turn on
because of internal power
supply fault.

Replace power supply.

Power supply shuts down
intermittently.

Power line selector switch on
rear of computer chassis not
switched to correct line voltage
(115V or 230V).

Select the proper AC voltage using the
slide switch.

Power supply will not turn on
because of internal power
supply fault.

Replace power supply.
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Solving Diskette Problems

Common causes and solutions for diskette problems are listed in the

following table:

[ vou may need to reconfigure the computer when you
add or remove hardware, such as an additiona diskette
drive. See “ Solving Hardware Installation Problems” for

instructions,

Problem

Cause

Solution

Diskette drive light
stays on.

Diskette is damaged.

In Windows 95, 98, or 2000, run ScanDisk.
Click Start > Programs > Accessories >
System Tools > ScanDisk.

In Windows NT, right click Start, click
Explore, and select a drive. Select File >
Properties - Tools. Under Error-checking,
click Check Now.

Diskette is incorrectly
inserted.

Remove diskette and reinsert.

Drive button is not pushed in.

Push in drive button.

Software program is
damaged.

Check the program diskettes.

Drive cable is not properly
connected.

Reconnect drive cable.

Drive not found.

Cable is loose.

Reseat diskette drive cable.

Diskette drive cannot
write to a diskette.

Diskette is not formatted.

Format the diskette.

Diskette is write-protected.

Use another diskette or remove the write
protection.

Writing to the wrong drive.

Check the drive letter in your path
statement.

Not enough space is left on
the diskette.

Use another diskette.

Diskette write control is
enabled.

Use Computer Setup to check your storage
security feature disabled settings.

Continued
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Solving Disk Problems continued

Problem

Cause

Solution

Cannot format
diskette.

Invalid media reported.

When formatting a disk in DOS, you may
need to specify diskette capacity. For
example, to format a 1.44-MB diskette,
type the following command at the DOS
prompt:

FORMAT A: /F:1440

A problem has
occurred with a disk
transaction.

The directory structure is
bad, or there is a problem
with a file.

In Windows 95, 98, or 2000, run
ScanDisk. Click

Start > Programs > Accessories >
System Tools &> ScanDisk.

In Windows NT, right click Start, click
Explore, and select a drive. Select File >
Properties - Tools. Under Error-checking,
click Check Now.

Diskette drive cannot
read a diskette.

Diskette is not formatted.

Format the diskette.

You are using the wrong
diskette type for the drive

type.

Check the type of drive you are using and
use the correct diskette type.

You are reading the wrong
drive.

Check the drive letter in the path
statement.

Nonsystem disk
message.

The system is trying to start
from a nonsystem diskette.

Remove the diskette from the drive.

Diskette MBR validation
enabled.

Disable the MBR validation option.

Diskette boot has been

disabled in Computer Setup.

Run Computer Setup and enable diskette
boot.
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Solving Hard Drive Problems

Problem

Cause

Solution

Hard drive error
occurs.

Hard disk has bad sectors or
has failed.

Use a utility to locate and block usage of
bad sectors. If necessary, reformat the
hard disk.

Disk transaction
problem.

Either the directory structure
is bad or there is a problem
with a file.

In Windows 95, 98, or 2000, run
ScanDisk. Click Start > Programs >
Accessories > System Tools >
ScanDisk.

In Windows NT, right click Start, click
Explore, and select a drive. Select File >
Properties - Tools. Under Error-checking,
click Check Now.

Drive not found
(identified).

Cable could be loose.

Check cable connections.

The system may not have
automatically recognized a
newly installed device.

See reconfiguration directions in the
“Hardware Installation Problems” section.
If system still does not recognize the new
device, check to see if the device is listed
within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is
not listed, the probable cause is a
hardware problem.

If this is a newly installed drive, enter
Setup and try adding a POST delay under
Advanced>Power-On Options>POST
Delay.

Drive jumper settings may be
incorrect.

If the drive is a secondary drive that has
just been installed on the same controller
as the primary drive, verify that the
jumpers for both drives are set correctly.

SCSI ID may be incorrect.

Check SCSI IDs to ensure none are
duplicated.

Continued
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Solving Hard Drive Problems continued

Problem Cause Solution
Nonsystem disk The system is trying to start  Remove the diskette from the diskette
message. from a diskette that is not drive.

bootable.

The system is trying to start
from the hard drive but the
hard drive may have been
damaged.

Insert a bootable diskette into the diskette
drive and restart the computer.

If the hard drive is still inaccessible after
booting to a diskette and MBR Security is
enabled, you may try restoring the
previously saved MBR image. To do so,
enter Setup and select Security>Restore
Master Boot Record.

Diskette boot has been

disabled in Computer Setup.

Run Computer Setup and enable diskette
boot.

System files missing or not
properly installed.

Insert a bootable system diskette and
restart. Verify hard drive is partitioned and
formatted. Install system files for the
appropriate operating system if necessary.

Hard drive boot has been

disabled in Computer Setup.

Run Computer Setup and enable the Hard
drive entry in the Storage>Boot Order list.

Second Ultra ATA You are using the wrong
hard drive does not cable for the drive type.
perform optimally.

Reinstall the second Ultra ATA hard drive
using an 80-conductor cable. The 80-
conductor cable is standard on select
models.
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Solving Display Problems

If you encounter display problems, refer to the documentation that
came with your monitor and to the common causes and solutions listed
in the following table:

Problem Cause Solution
Blank screen. Monitor is not turned on and  Turn on the monitor and check that the
the monitor light is not on. monitor light is on.

The cable connections are Check the cable connection from the monitor

not correct. to the computer and to the electrical outlet.
The energy saver feature Press any key or click the mouse button
has been enabled. and, if set, type your password.

The RGB (Red, Green, Set the monitor's RGB input switch to 75
Blue) input switch on the ohms and, if there is a sync switch, set it to
monitor is incorrectly set. External.

System ROM is bad; system Reflash the ROM using a ROMPaq diskette.
is running in Failsafe Boot Refer to the “Failsafe Boot Block ROM”
Block mode (indicated by section of the Desktop Management guide
one long beep and three for more information.

short beeps).

You are using a fixed-sync Be sure that the monitor can accept the
monitor and it won't sync at  same sweep rate as the resolution chosen.
the resolution chosen.

The VGA/BNC selector Set the selector switch to agree with the
switch is not properly set. cable connection.
Monitor does not Monitor without energy Disable monitor energy saver feature.
function properly when saver capabilities is being
used with energy used with energy saver
saver features. features enabled.
Continued
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Solving Display Problems continued

Problem

Cause

Solution

Graphics colors are
wrong.

The cabling or monitor
impedance is incorrect.

1. If you are using BNC cables, be sure
that the Red, Green, and Blue BNC
cables are connected to the
corresponding monitor connectors.

2. Be sure your monitor's RGB inputs
are set to 75 ohms.

Dim characters.

The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast
controls.

Cables are not properly
connected.

Check that the graphics cable is securely
connected to the graphics card and the
monitor.

The RGB switch on the back
of the monitor is incorrectly
set.

Set the RGB switch (and sync options, if
this option is available) to 75 ohms, with
the sync set to external. Refer to the
documentation included with the monitor.

Blurry video or
requested resolution
cannot be set.

If the graphics controller was
upgraded, the correct
graphics drivers may not be
loaded.

Install the video drivers on the diskette
included in the upgrade Kkit.

Screen goes blank.

You may have a screen
blanking utility installed or
energy saver features are
enabled.

Press any key or type password.

The picture is broken
up, or it rolls, jitters, or
blinks.

The monitor connections
may be incomplete or the
monitor may be incorrectly
adjusted.

1. Be sure the monitor cable is securely
connected to the computer.

2.  In a 2-monitor system or if another
monitor is in close proximity, be sure
the monitors are not interfering with
each other’s electromagnetic field by
moving them apart.

3.  Fluorescent lights or fans may be too
close to the monitor.

Monitor overheats.

There is not enough
ventilation space for proper
airflow.

Leave at least 3 inches (7.6 cm) of
ventilation space. Be sure there is nothing
sitting on top of the monitor obstructing
the air flow.
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Solving Audio Problems

If your computer has audio features and you encounter audio problems,
refer to the common causes and solutions listed in the following table;

Problem

Cause

Solution

Sound does not come out
of the speaker or
headphones.

Software volume control is
turned down.

Doubile click on the speaker
icon on the taskbar, then set
volume by adjusting the
volume slider.

CD-ROM or DVD volume
control on the front of the
computer is turned down.

Turn the volume control knob
on front of computer to
increase the volume.

External speakers turned off.

Turn external speakers on.

External speakers plugged into
the wrong audio jack.

Refer to the Computer User’s
Guide or Sound card
documentation for proper
speaker connection.
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Solving Printer Problems

If you encounter printer problems, refer to the documentation that came
with your printer and to the common causes and solutions listed in the

following table:

Problem Cause Solution
Printer will not  Printer is not turned on and online.  Turn the printer on and make sure it is online.
print.
The correct printer drivers for your 1.  Install the correct printer driver for your
application are not installed. application.

2. Try printing using the DOS command
DIR C:\ > [printer port]
where [printer port] is the address of the
printer being used.
If printer works, reload printer driver.

If you are on a network, you may
not have made the connection to
the printer.

Make the proper network connections to the
printer.

Printer may have failed.

Run printer self-test.

Printer will not

The cables may not be connected

Reconnect all cables and check the power

turn on. properly. cord and electrical outlet.
Prints garbled  The correct printer driver for your Install the correct printer driver for your
information. application is not installed. application.

The cables may not be connected Reconnect all cables.

properly.
Printer is The printer may be out of paper. Check the paper tray and refill it if it is empty
offline. Select online.
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Solving Hardware Installation Problems

Y ou may need to reconfigure the computer when you add or remove
hardware, such as an additional diskette drive. If you install a Plug and
Play device, Windows 95, 98, and 2000 automatically recognize the
device and configure the computer. If you install a non—-Plug and Play
device, you must reconfigure the computer after completing installation

of the new hardware. In Windows 95, 98, and 2000, select the Add

New Hardware icon in the Control Panel and follow the instructions
that appear on the screen. To reconfigure the computer in Windows NT
4.0 after installing new hardware, use the utility provided with the

hardware.

Problem

Cause

Solution

A new device is not
recognized as part of
the computer system.

The computer needs to be
reconfigured to recognize the
device.

Follow the reconfiguration instructions
above.

Cable(s) of new external
device are loose or power
cables are unplugged.

Ensure that all cables are properly and
securely connected and that pins in the
cable or connector are not bent down.

Power switch of new external
device is not turned on.

Turn off the computer, turn on the external
device, then turn on the computer to
integrate the device with the computer
system.

When the system advised you
of changes to the
configuration, you did not
accept them.

Reboot the computer and follow the
instructions for accepting the changes.

A Plug and Play board may
not automatically configure
when added if the default
configuration conflicts with
other devices.

Use Windows 95, 98, or 2000 Device
Manager to deselect the automatic
settings for the board and choose a basic
configuration that doesn’t cause a
resource conflict. You can also use
Computer Setup to reconfigure or disable
devices to resolve the resource conflict.
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Solving Network Problems

Some common causes and solutions for network problems are listed in
the following table. These guidelines do not discuss the process of

debugging the network cabling.

Problem

Cause

Solution

Remote Wakeup feature
is not functioning.

The Remote Wakeup feature
is not available when using an
AUI network connection.

Use an RJ-45 network
connection.

Remote Wakeup is not
enabled.

Use the Network control
application to enable Remote
Wakeup. Refer to the Desktop
Management guide.

Network driver does not

detect network controller.

Network controller is disabled.

Run Computer Setup and
enable network controller.

Incorrect Network Driver.

Check the network controller
documentation for the correct
driver or obtain the latest
driver from the manufacturers
Web site.

Network status link light
does not turn on or
flashes.

No active network is detected.

Check cabling and network
equipment for proper
connection.

Network controller is not set up
properly.

Use the Network control
application to verify that device
is working properly. Refer to
the Using Network
Communications guide.

System is configured for AUI
connection.

No solution; link LED does not
apply to AUI connections.

Network driver is not properly
loaded.

Reinstall network drivers.
Refer to the Using Network
Communications guide.

System cannot autosense the
network.

Disable autosensing
capabilities and force the
system into the correct
operating mode. Refer to the
Using Network
Communications guide.

Continued
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Solving Network Problems continued

Problem

Cause

Solution

Diagnostics reports a
failure.

The cable is not securely
connected.

Ensure that the cable is
securely attached to the
network connector and that the
other end of the cable is
securely attached to the
correct device.

The cable is attached to the
incorrect connector.

Ensure that the cable is
attached to the correct
connector.

There is a problem with the
cable or a device at the other
end of the cable.

Ensure that the cable and
device at the other end are
operating correctly.

The network controller is
defective.

Contact your Compaq
authorized service provider.

Network controller interrupt is
shared with an expansion
card.

Under the Computer Setup
Advanced menu, change the
resource settings for the card.

Diagnostics passes, but
the computer does not
communicate with the
network.

Network drivers are not
loaded, or driver parameters
do not match current
configuration.

Make sure the network drivers
are loaded and that the driver
parameters match the
configuration of the network
controller.

Make sure the correct network
client and protocol is installed.

The network controller is not
configured for this computer.

Select the Network icon at the
Control Panel and configure
the network controller.

Continued
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Solving Network Problems continued

Problem

Cause

Solution

Network controller
stopped working when an
expansion board was
added to the computer.

Network controller interrupt is
shared with an expansion
board.

Under the Computer Setup
Advanced menu, change the
resource settings for the
board.

The network controller
requires drivers.

Verify that the drivers were not
accidentally deleted when the
drivers for a new expansion
board were installed.

The files containing the
network drivers are corrupted.

Reinstall the network drivers,
using the Compaq Restore
CD.

Network controller
stopped working without
apparent cause.

The files containing the
network drivers are corrupted.

Reinstall the network drivers,
using the Compaq Restore
CD.

The cable is not securely
connected.

Ensure that the cable is
securely attached to the
network connector and that the
other end of the cable is
securely attached to the
correct device.

The network controller is
defective.

Contact your Compaq
authorized service provider.

New network card will not
boot.

New network card may not be
Compaqg compatible.

Install Compaq-compatible
NIC or change boot sequence
to boot from another device.

Cannot connect to
network server when
attempting Remote
System Installation.

The network controller is not
configured properly.

Run Computer Setup (F10
Setup) and modify the NIC
Settings.

System setup utility
reports unprogrammed
EEPROM.

Unprogrammed EEPROM.

Contact your Compaq
authorized service provider.
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Solving Memory Problems

If you encounter memory problems, some common causes and

solutions are listed in the following table:

Problem

Cause

Solution

System won't boot or
does not function
properly after installing
additional memory
modules.

Memory module is not the
correct type or speed grade
for the system or the new
memory module is not seated

properly.

Out of Memory error.

Memory configuration may not
be set up correctly.

You have run out of memory
to run the application.

Memory count during
POST is wrong.

The memory modules may not
be installed correctly.

Insufficient memory
error during operation.

Too many Terminate and Stay
Resident programs (TSRs)

are installed.

You have run out of memory
for your application.

computer.

Unit is on but there is
no video and the power
LED is blinking red.

Memory is not installed
correctly and system is not
booting.
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Replace module with the correct industry-
standard device for your computer.

Use the Device Manager to check
memory configuration.

Check the application documentation to
determine the memory requirements.

Check that the memory modules have
been installed correctly and that proper
modules are used.

Delete any TSRs that you do not need.

Check the memory requirements for the
application or add more memory to the

Reinstall memory modules.



Solving SCSI Problems

If you encounter SCSI device problems, refer to the common causes
and solutions listed in the following table:

Problem

Cause

Solution

System with IDE and
SCSI drives will not
boot from SCSI hard
drive.

The IDE drive is not
disabled through the
Computer Setup utility.

Under the Computer Setup Advanced
menu, disable the primary IDE
controller.

Note: Computers configured with both
SCSI and IDE hard drives will boot to
the IDE drive.

An IDE drive is attached,
the IDE controller is
enabled, and the Integrated
IDE controller is listed
before the SCSI adapter in
Setup’s Storage>Controller
Order menu.

Under Computer Setup, select
Storage>Controller Order, and move
the Integrated IDE controller to the end
of the list.

System without an
IDE drive will not
boot from a SCSI
drive.

The SCSI drive is not
configured correctly.

Ensure that drive cabling and jumpers
are set correctly. To boot a SCSI drive,
the drive ID number must be set to 0.

Hard drive boot has been
disabled in Computer
Setup.

Under Computer Setup, select
Storage>Boot Order, and enable the
Hard Drive entry.
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Solving CD-ROM and DVD Problems

If you encounter CD-ROM or DVD problems, refer to the common
causes and solutions listed in the following table or to the
documentation that came with the optional device.

Problem Cause Solution

System will not boot The CD-ROM or DVD boot is Run the Computer Setup utility (F10

from CD-ROM or DVD  not enabled through the Setup) and enable booting to removable

drive. Computer Setup utility. media and verify boot order settings.
Non-bootable CD in drive. Try a bootable CD in the drive.

CD-ROM or DVD Drive is not connected Refer to the documentation that came with

device is not detected  properly or not properly the optional device.

or driver is not loaded.  configured.

Movie will not play in Movie may be regionalized for Refer to the documentation that came with

the DVD drive. a different country. the DVD drive.

Cannot eject compact  Disc not properly seated in the Turn off computer and insert a thin metal

disc (tray-load unit). drive. rod into the emergency eject hole and
push firmly. Slowly pull the tray out from
the drive until the tray is fully extended,
then remove the disc.

Solving Software Problems

Most software problems occur as a result of the following:

m  The application was not installed or configured correctly.

m  Thereisinsufficient memory available to run the application.
m  Thereisaconflict between applications.

Where available, run the Compaq Configuration Utility to determine if
any changes have been made to the software which may be causing a
problem. Refer to the online Desktop Management guide for more
information.
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Troubleshooting Using Compaq Desktop Management Features

Compaq Insight Manager L C with Compagq Insight Manager XE
produces a full suite of applications ranging from hardware, fault, and
asset management, to desktop software management, to intelligent
Windows NT cluster monitoring and administration. The browser-
based user interface for Compag Insight Manager LC and Compag
Insight Manager XE maintain a consistent look and feel with many
shared elements, including color coded status indicators and consistent
actions and controls whether managing a small workgroup or the most
complex network that manages devices across the enterprise.

Compaq Insight Manager L C can automatically discover, view system
information and receive alerts from any DMI 2.0 PC on a specified
domain or workgroup. With the use of Compag Management Agents,
an administrator can change security settings, run diagnostic tests
remotely and even update system software such as BIOS and drivers.

Contacting Compaq Customer Support

For help and service, contact your Compaq authorized reseller or
dedler.

] If you take your computer to a Compaq authorized
reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords,
if they are set.
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appendixA
POST ERROR MESSAGES

Error Codes
This chapter lists the error codes that you may encounter during the
Power-On Self-Test (POST) or computer restart, the probable source of
the problem, and what steps you can take to resolve the error condition.
Power-0n Self-Test Messages

Message Beeps* Probable Cause Recommended Action

101-Option ROM 1L, 1S System ROM checksum. 1. Verify the correct ROM

Error 2. Flash the ROM if needed.

3. If an expansion card was recently
added, remove it and see if the
problem remains.

4. Clear CMOS.

If the message disappears, there
may be a problem with the
expansion card.

6. Replace the system board.

102-System Board None DMA, timers, etc. 1. Clear CMOS.
Failure 2. Remove expansion boards.

3. Replace the system board.

103-System Board None DMA, timers, etc. 1. Clear CMOS.
Failure 2. Remove expansion boards.

3. Replace the system board.

150-SafePost Active  None A PCI expansion card is not 1. Restart the computer.
responding. 2. Disable SafePost.

If the expansion card does not
respond, replace the card.

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message

Beeps*

Probable Cause

Recommended Action

162-System Options  2S
Not Set

Configuration incorrect.

RTC (real-time clock) battery
may need to be replaced.
Battery life is approximately
3 years.

Run Computer Setup (F10 Setup).

Reset the date and time under Control
Panel. If the problem persists, replace
the RTC battery. Refer to the Hardware
Reference Guide for instructions on
installing a new battery, or contact your
Compagq authorized dealer or reseller
for RTC battery replacement.

163-Time & Date 2S
Not Set

Invalid time or date in
configuration memory.

RTC (real-time clock) battery
may need to be replaced.
Battery life is approximately
3 years.

CMOS jumper may not be
properly installed

Reset the date and time under Control
Panel. If the problem persists, replace
the RTC battery. Refer to the Hardware
Reference Guide for instructions on
installing a new battery, or contact your
Compagq authorized dealer or reseller
for RTC battery replacement.

Check for proper placement of the
CMOS jumper (if applicable).

164-Memory Size 2S
Error

Memory configuration
incorrect.

1. Run Computer Setup (F10 Setup)
or Windows utilities.

2. Make sure your memory
module(s) are installed properly.

3. If third party memory has been
added, test using Compag-only
memory.

4. Verify proper memory module
type.

183-Invalid 28
Processor Jumper
Setting

System board jumper
improperly set.

Reset system board jumpers to match
processor and bus speeds (select
models).

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
201-Memory Error None RAM failure. 1. Run Computer Setup (F10 Setup)
or Windows utilities.

2. Ensure memory and continuity
modules are installed correctly.

3. Verify proper memory module
type.

4. Remove and replace the memory
module(s) one at a time to isolate
faulty module.

5. Replace faulty memory module(s).

6. If error persists after replacing
memory modules, replace the
system board.

202-Memory Type None Memory modules do not Replace memory modules with

Mismatch match each other. matched sets.

207-ECC Corrected  2S Single Bit ECC error. 1. Verify proper memory module

Single Bit Errors in type.

Memory Module 2. Try another memory socket.

Socket(s) y,y,...
Replace memory module if
problem persists.

212-Failed None Processor has failed to 1. Reseat the processor in its socket.

Processor initialize. 2. If the processor does not respond,
replace it.

213-Incompatible 2S A memory module in memory 1. Verify proper memory module

memory Module in socket identified in the error type.

memory Socket(s) message is missing critical 2. Try another memory socket.

X, X, ... SPD information, or is ]

incompatible with the chipset. Replace DIMM with a module

conforming to the SPD standard.

214-Memory Device  None A specific error has occurred 1. Verify proper memory module

Failure. Error
code:XX, Memory
Module Socket(s):XX

in a memory device installed
in the identified socket.

type,

2. Try another memory socket.

Replace memory module if
problem persists.

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
301-Keyboard Error  None Keyboard failure. 1. Reconnect keyboard with
computer turned off.

2. Check connector for bent or

missing pins.

3. Ensure that none of the keys are

depressed.

4. Replace keyboard.
304-Keyboard or None Keyboard failure. 1. Reconnect the keyboard with
System Unit Error computer turned off.

2. Ensure that none of the keys are

depressed.

3. Replace the keyboard.

4. Replace the system board.
401-Parallel Port 1 2S IRQ address conflicts with Reset the IRQ.

Address Assignment another device.

Conflict

403-Parallel Port 3 28 IRQ address conflicts with Reset the IRQ.

Address Conflict another device.

Detected

404-Parallel Port 28 Both external and internal 1. Remove any parallel port

Address Conflict ports are assigned to parallel expansion cards.

Detected port X. Clear CMOS.
Reconfigure card resources and/or
run Computer Setup (F10 Setup).

410-Audio Interrupt 2SS IRQ address conflicts with Reset the IRQ.

Conflict another device.

411-Network 28 IRQ address conflicts with Reset the IRQ.

Interface Card another device.

Interrupt Conflict

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
501-Display Adapter 1L, 2S Graphics display controller. 1. Reseat the graphics card (if
Failure applicable).

Clear CMOS.

3. Verify monitor is attached and

turned on.

4. Replace the graphics controller.
601-Diskette None Diskette controller circuitry or 1. Run Computer Setup (F10 Setup).
Controller Error floppy drive circuitry incorrect. 2. Check and/or replace cables.

3. Clear CMOS.

4. Replace diskette drive.

5. Replace the system board.
602-Diskette Boot None Diskette in Drive A not Replace the diskette.

Record Error bootable.

605-Diskette Drive 2S Mismatch in drive type. 1. Run Computer Setup (F10 Setup)

Type Error or Windows NT, Windows 95, or
Windows 98 utilities.

2. Disconnect any other diskette

controller devices (tape drives).

3. Clear CMOS.
610-External None External tape drive not Reinstall tape drive or press F1 and
Storage Device connected. allow system to reconfigure without the
Failure drive.
612-Secondary 28 Configuration error. 1. Run Computer Setup (F10 Setup).
Floppy Port Address 2. Remove expansion cards.
Assignment Conflict

3. Clear CMOS.
660-Display cache is None Integrated graphics controller  Replace system board if minimal

detected unreliable

display cache not working
properly and will be disabled.

graphics degrading is an issue.

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
912- Computer None No action required.
Cover Has Been
Removed Since Last
System Startup
914-Hood Lock Coil  None Smart Cover Lock mechanism 1. Reconnect or replace hood locking
is not Connected is missing or not connected. mechanism.
2. Reseat or replace hood locking
mechanism cable.
916-Thermal Sensor None Processor heatsink cable not  Reseat or replace the processor
from Processor connected to system board. heatsink cable going to the system
Heatsink is not board.
Connected
917-Expansion Riser None Riser board not seated or not  Install riser board if missing or remove

not Detected

installed.

and reseat to ensure good connection.

1151-Serial Port 1 2S
Address Conflict
Detected

Both external and internal
serial ports are assigned to
COM1.

1.

Remove any serial port expansion
cards.

Clear CMOS.

Reconfigure card resources and/or
run Computer Setup (F10 Setup)
or Windows utilities.

1152- Serial Port 2 2S
Address Conflict

Both external and internal
serial ports are assigned to

Remove any serial port expansion
cards.

Detected COM2. Clear CMOS.
Reconfigure card resources and/or
run Computer Setup (F10 Setup)
or Windows utilities.

1155-Serial Port 28 Both external and internal 1. Remove any serial port expansion

Address Conflict serial ports are assigned to cards.

Detected same IRQ.

Clear CMOS.

Reconfigure card resources and/or
run Computer Setup (F10 Setup)
or Windows utilities.

1201-System Audio  2S
Address Conflict
Detected

Device IRQ address conflicts
with another device.

Reset the IRQ.

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
1202-MIDI Port 28 Device IRQ address conflicts ~ Reset the IRQ.

Address Conflict with another device.

Detected

1203-Game Port 28 Device IRQ address conflicts ~ Reset the IRQ.

Address Conflict with another device.

Detected

1611-Fan failure None Chassis fan not connected to 1. Reconnect the fan.
detected the system board. 2. Replace the fan.

3. Replace the system board.
1720-SMART Hard None Hard drive is about to fail. 1. Determine if hard drive is giving
Drive Detects (Some hard drives have a correct error message. Run the
Imminent Failure firmware patch that will fix an Drive Protection System test if

erroneous error message). available.

2. Apply firmware patch if applicable.

(See www.compag.com\support\
techpubs\customer_advisories)

3. Back up contents and replace

hard drive.
1721-SMART SCSI None Hard drive is about to fail. 1. Determine if hard drive is giving

Hard Drive Detects
Imminent Failure

(Some hard drives have a
firmware patch that will fix an
erroneous error message).

correct error message.

2. Apply firmware patch if applicable.

Back up contents and replace
hard drive.

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
1800-Temperature None Internal temperature exceeds 1. Check that computer air vents are
Alert specification. not blocked and cooling fan is
running.
2. Verify processor speed selection.
3. Replace the processor.
4. Replace the system board.
1801 None Processor not supported by Upgrade BIOS to proper version.
ROM Bios.
Audible 1L, 3S System ROM is bad; system Reflash the ROM using a ROMPaq
is running in Failsafe Boot diskette. Refer to the “Failsafe Boot
Block mode. Block ROM” section of the Desktop
Management guide.
Audible 28 Power-on successful. None.
Flashing Caps Lock 1L, 2S Graphics controller not 1. Clear CMOS.
LED on Keyboard .pr.e.se.nt or incorrectly 2. If graphics card has been added,
initialized. remove and reseat.
3. Reseat riser board if applicable.
Flashing Num Lock 1S, 2L System memory not present. 1. Check memory module (refer to
LED on Keyboard the relevant section of the
Hardware Reference Guide
guide).
2. Remove and reseat memory
module.
3. See the “Solving Memory
Problems” section of this guide.
Num Lock LED ON None Failed Boot Block. Reflash the ROM using a ROMPaq
(keyboard) diskette. Refer to the “Failsafe Boot
Block ROM” section of the Desktop
Management guide.
Flashing Scroll Lock 2L, 1S System board hardware Replace system board.

LED on keyboard

failure (prior to graphics).

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action

Green Power LED None Computer in normal Suspend  None

Blinks 1x / Second. mode.

Green Power LED None Computer on. None

On

Invalid Electronic None Electronic serial number has 1. Run Computer Setup. If Setup
Serial Number become corrupted. already has data in the field or will

not allow the serial number to be
entered, download from
www.compag.com and run
SP5572.EXE (SNZERO.EXE).

2. Run F10 Setup and try to enter
serial number under Security,
System ID, then save changes.

Flashing Power and  None Unseated riser board. 1. Remove riser board.
Hard Drive Green

2. Wipe connector.
LEDs

Reinstall riser board (refer to the
Hardware Reference Guide guide
for directions on removing the riser
board).

Red Power LED None Power supply overloaded. 1. Push in power button. LED should
Blinks Every 2 or be green.

more Seconds. 2. Remove all AC power from

computer, wait 30 seconds, then
apply power.

3. Remove load from power supply
by removing options one at a time
until computer runs.

4. Check for damage to system
board.

Replace system board.
Replace power supply.
*L =Long, S = Short Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action

Red Power LED None System memory error. 1. Check memory module (refer to

Blinks Every Second the relevant section of the
Hardware Reference Guide
guide).

2. Remove and reseat memory
module.

3. See the “Solving Memory
Problems” section of this guide.

Red Power LED None Computer overheated. 1. Install computer cover or access

Blinks Four Times panel if necessary.

per Second 2. Ensure that computer air vents are
not blocked and internal fan is
running.

Red Power LED On  None Processor unseated. Reseat processor in system board.

XXXOO0OQYZZ Parity None Parity RAM failure. Run Computer Setup and Diagnostic

Check 2 Utilities.

Invalid Electronic None Electronic serial number has 1. Run F10 Setup, try to enter serial

Serial Number become corrupted. number under Security, System

ID, and save changes.

2. Run Computer Setup. If Setup
already has data in the field or will
not allow the serial number to be
entered, download and run
SP5572.EXE (SNZERO.EXE) from
www.compag.com.

*L =Long, S = Short

[] If you have replaced the standard keyboard with a
Universal Serial Bus (USB) keyboard, you will hear the
beep sequences for these error codes but will not see the
flashing keyboard lights.
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appendix B

PASSWORD SECURITY AND
RESETTING CMOS

This computer supports security password features, which can be
established through the Computer Setup Utilities menu.

This computer supports two security password features that are
established through the Computer Setup (F10 Setup) Utilities menu:
setup password and power-on password. When you establish only a
setup password, any user can access al the information on the
computer except Computer Setup (F10 Setup). When you establish
only a power-on password, the power-on password is required to
access Computer Setup (F10 Setup) and any other information on the
computer. When you establish both passwords, only the setup
password will give you access to Computer Setup (F10 Setup).

When both passwords are set, the setup password can also be used in
place of the power-on password as an override to log into the
computer. Thisis auseful feature for a network administrator.

If you forget the password for your computer, there are two methods
for clearing that password so you may gain access to the information
on the computer:

m  Resetting the password jumper
m  Using the Clear CMOS button

CAUTION: Pushing the CMOS button will reset CMOS values to factory
defaults and will erase any customized information including passwords,
asset numbers, and special settings.
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Resetting the Password Jumper

To disable the power-on or setup password features, or to clear the
power-on or setup passwords, compl ete the following steps:

1. Turn off the computer and any external devices, and disconnect
the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external devices
connected to the computer.

WARNING: To reduce the risk of personal injury from electrical shock and/or
hot surfaces, be sure to disconnect the power cord from the wall outlet, and
allow the internal system components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has
voltage applied to the system board even when the unit is turned off. Failure
to disconnect the power cord can result in damage to the system.

i

CAUTION: Static electricity can damage the electronic components of the
computer or optional equipment. Before beginning these procedures, ensure
that you are discharged of static electricity by briefly touching a grounded
metal object. Refer to the Safety & Regulatory Information guide for more
information.

3. Remove the computer cover or access panel.
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4. Locate the header and jumper

[]

On most system boards, the header is labeled E49.

Location and Identification of the Password Jumper on a Compaq Deskpro EN
Configurable Minitower System Board (Intel 810 Chipset)

[]

10.

Y our system board may differ from the sample shown,
Remove the jumper from pins 1 and 2. Place the jumper over pin 2
only, in order to avoid losing it.

Replace the computer cover or access panel.
Reconnect the external equipment.

Plug in the computer and turn on power. Allow the operating
system to start. This clears the current passwords and disables the
password features.

To re-enable the password features, repeat steps 1-4, then replace
the jumper on pins 1 and 2.

Repeat steps 6-8, then establish new passwords. Refer to the
Hardware Reference Guide for Computer Setup (F10 Setup)
instructions.
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Clearing and Resetting the CMOS

The computer’s configuration memory (CMOS) stores password
information as well information about the computer’ s configuration.

Using the CMOS Button

1. Turn off the computer and any external devices, and disconnect
the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external
equipment connected to the computer.

WARNING: To reduce the risk of personal injury from electrical shock and/or
hot surfaces, be sure to disconnect the power cord from the wall outlet, and
allow the internal system components to cool before touching.

When the computer is plugged in, the power supply always has voltage
applied to the system board even when the unit is turned off. Failure to
disconnect the power cord can result in damage to the system.

I

CAUTION: Static electricity can damage the electronic components of the
computer or optional equipment. Before beginning these procedures, ensure
that you are discharged of static electricity by briefly touching a grounded
metal object. Refer to the Safety & Regulatory Information guide for more
information.

3. Remove the computer cover or access panel.
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4. Locate, press, and hold the CMOS button in for 5 seconds.

CAUTION: Pushing the CMOS button will reset CMOS values to factory
defaults and will erase any customized information including passwords,
asset numbers, and special settings.

CMOS Pushbutton

5. Replace the computer cover or access panel.

6. Reconnect the external devices.

7. Pluginthe computer and turn on power.

[ Youwill need to reset your passwords and any special
system setups along with the date and time. Refer to the

“Using Computer Setup” section below for further
instructions
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Using Computer Setup to Reset CMOS

To reset CMOS, you must first access the Computer Setup (F10 Setup)
Utilities menu.

When the Computer Setup (F10 Setup) message appears in the lower-
right corner of the screen, press the F10 key. Press Enter to bypass the
title screen, if necessary.

[] If you do not press the F10 key while the messageis
displayed, you must turn the computer off, then on
again, to access the utility.

A choice of five headings appears in the Computer Setup (F10 Setup)
Utilities menu: File, Storage, Security, Power, and Advanced.

To reset CMOS to the factory default settings first set time and date,
then use the arrow keys or the Tab key to select File— Set Defaults and
Exit.

Refer to the Desktop Management guide for further instructions on
reestablishing passwords. For instructions on Computer Setup
(F10 Setup), see Hardware Reference Guide.
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appendix C

DRIVE PROTECTION SYSTEM
(DPS)

Introducing the Drive Protection System

The Compaq Drive Protection System (DPS) is adiagnostic tool built
into the hard drivesinstalled in select Compaq Deskpro computers and
Workstations. DPS is designed to help diagnose problems that might
result in unwarranted hard drive replacement.

When Compag Deskpro Computers and Workstations are built, each
installed hard drive istested using DPS and a permanent record of key
information is written onto the drive. Each time DPS s run, test results
are written to the hard drive. Y our service provider can use this
information to help diagnose conditions that caused you to run the
DPS software.

Running DPS will not affect any programs or data stored on the hard
drive. Thetest resides in the hard drive firmware and can be executed
even if the computer will not boot to an operating system. The time
required to execute the test depends on the manufacturer and size of the
hard drive; in most cases, the test will take approximately 2 minutes
per gigabyte.

Use DPS when you suspect a hard drive problem. If the computer
reports a SMART Hard Drive Detect Imminent Failure message, there
is no need to run DPS; instead, back up the information on the hard
drive and contact your Compagq service provider for a replacement
hard drive.
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Accessing DPS Through Compaq Diagnostics for Windows

To access DPS through Compaq Diagnostics for Windows, perform the
following steps:

1. Turn onthe computer and select My Computer - Control
Panel — Compaq Diagnostics.
A choice of five possible headings appears in the Diagnostics
screen: Overview, Test, Status, Log, and Error.

2. Select Test— Type of Test
A choice of three tests appear: Quick Test, Complete Test, and
Custom Test.

3. Select Custom Test.
A choice of two test modes s offered: Interactive Mode and
Unattended Mode.

4. Select Interactive Test - Storage - Hard Drives.

5. Select the specific drive(s) to be tested . Drive Protection System
Test - Begin Testing.

When the test has been completed, one of three messages will be
displayed for each of the drives tested:

m  Test Succeeded. Completion Code 0.
m  Test Aborted. Completion Code 1 or 2.

m Test Failed. Drive Replacement Recommended. Completion
Code 3 through 14.

If the test failed, the completion code should be recorded and reported
to your service provider for help in diagnosing the computer problem.
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Accessing DPS Through Computer Setup

When the computer does not power-on properly you should use
Computer Setup (F10 Setup) to access the DPS program. To access
DPS, perform the following steps:

1. Turnonor restart the computer.
2. When the F10 Setup message appears in the lower-right corner of
the screen, press the F10 key.

[] If you do not press the F10 key while the messageis
displayed, you must turn the computer off, then on
again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities
menu: File, Storage, Security, Power, and Advanced.

3. Select Storage— IDE DPS Self-Test.
The computer screen will display thelist of DPS-capable hard
drivesthat are installed on the computer.

] If no DPS capable hard drives are installed, the IDE DPS
Self-Test option will not appear on the screen.

4. Select the hard drive to be tested and follow the screen prompts to
complete the testing process.

When the test has been completed, one of three messages will be
displayed:

m  Test Succeeded. Completion Code O.

m  Test Aborted. Completion Code 1 or 2.

m Test Failed. Drive Replacement Recommended. Completion
Code 3 through 14.

If the test failed, the completion code should be recorded and reported
to your service provider for help in diagnosing the computer problem.
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A

audio problems, solving, 2-12
Automatic Diagnostics, 1-3

c

CD-ROM problems, solving, 2-20

CMOS, clearing, B-4

Computer Checkup (TEST), 1-2

configuration memory, clearing,
B-4

customer support, contacting, 2-21

D

disk problems, solving, 2-6
DVD problems, solving, 2-20

F
Full Boot, 2-1

G
graphics problems, solving, 2-10
H

hardware installation problems,
solving, 2-14
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INSPECT, 1-3

J

jumper, password, B-2

L
LED flashing codes, A-8

m

memory problems, solving, 2-18

N

network problems, solving, 2-15

P

password jumper, B-2

Plug and Play, 2-14

power supply problems

troubleshooting, 2-5

power-on password, B-1

Power-On Self-Test (POST)
messages, A-1

printer problems, solving, 2-13

protecting software, 1-7

Q

Quick Boot, 2-1
Quick Check Diagnostics, 1-3

R

reconfiguring the computer, 2-6,
2-14

recovering software, 1-7

Restore CD, 1-7

S

SCSI problems, solving, 2-19
setup password, B-1

software
protecting, 1-7
recovery, 1-7

software problems, solving, 2-20
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TEST. See Computer Checkup
troubleshooting

audio problems, 2-12

CD-ROM problems, 2-20

contacting Compag customer
support, 2-21

disk problems, 2-6

DVD problems, 2-20

graphics problems, 2-10

hardware installation problems,
2-14

memory problems, 2-18

network problems, 2-15

power supply, 2-5

printer problems, 2-13

SCSI problems, 2-19

software problems, 2-20

View System Information

(INSPECT), 1-3

I-2 Index



	Troubleshooting Guide
	Notice
	CONTENTS
	COMPUTER DIAGNOSTIC FEATURES
	Computer Diagnostics
	Protecting Your Software

	TROUBLESHOOTING WITHOUT DIAGNOSTICS
	Helpful Hints
	Solving Minor Problems
	Solving Power Supply Problems
	Solving Diskette Problems
	Solving Hard Drive Problems
	Solving Display Problems
	Solving Audio Problems
	Solving Printer Problems
	Solving Hardware Installation Problems
	Solving Network Problems
	Solving Memory Problems
	Solving SCSI Problems
	Solving CD-ROM and DVD Problems
	Solving Software Problems
	Troubleshooting Using Compaq Desktop Management Features
	Contacting Compaq Customer Support

	POST ERROR MESSAGES
	Error Codes

	PASSWORD SECURITY AND RESETTING CMOS
	Resetting the Password Jumper
	Clearing and Resetting the CMOS

	DRIVE PROTECTION SYSTEM (DPS)
	Introducing the Drive Protection System
	Accessing DPS Through Compaq Diagnostics for Windows
	Accessing DPS Through Computer Setup

	INDEX

